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1 Introduction

Template Builder is a web application that allows journalists and content creators to edit and build 

customized templates based on existing templates.

The templates can be customized with different functionalities described in this guide. The major 

functionality in Template Builder is the possibility to add custom HTML panels to the forms used to edit 

the templates which gives the user full control over the template.

1.1 Workflow

The basic workflow from graphics design to a working template is as follows:

Scenes are made in Viz Artist. Multiple scenes can make up one template, categorized under 

different variants.

Objects in the scene, that the graphics designer wants to make editable in the finished template, are 

given the appropriate control plugins.

Templates are made in Template Wizard, after importing the scene(s) over.

These templates are saved within the Pilot system and are available to the Template Builder.

In Template Builder a template can be opened, edited/customized and previewed.

The template is saved back into the Pilot system and are made available to the newsroom and control 

room systems.

A journalist, editor or other content creator, fills the graphics template with content. This can 

include: text, numbers, images, videos, websites and maps. The template is saved into the Viz Pilot 

system creating a data element that is added to the newsroom story.
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1.  
2.  

3.  
4.  
5.  

The Viz Pilot operator monitors the newsroom playlist (rundown) and plays the graphics on-air at the 

correct time in the broadcast.

1.2 Document Structure

This User's Guide is divided into the following chapters:

Introduction

Setup

Using the Template Builder

1.3 Related Documents

The templates customized in Template Builder can be used by other Viz products like Viz Pilot Edge, Viz 

Story and Viz Multiplay.

For more information about all of the Vizrt products, visit:

www.vizrt.com

Vizrt Documentation Center

Vizrt Training Center

Vizrt Forum

1.4 Customer Feedback and Suggestions

We encourage suggestions and feedback about our products and documentation.

To give feedback and, or suggestions, please identify your local Vizrt customer support team at www.vizrt.

.com

Click on  (top of page).Contact
The Vizrt office which is nearest to your location will be shown, or select from the list of Vizrt 

offices.

Click on the  button for the office you want.Contact
Complete the required details in the window that open

A Vizrt representative will contact you as soon as possible.

Note

The changes made to a template in Template Builder will not be available in the template in Template 

Wizard

......................................................................................................................................................................

......................................................................................................................................................................

Note

If this message is for Customer Support, and there is a Support Contract in place, then click on 

the ‘For support requests, please visit our support portal’ link in the message window.

......................................................................................................................................................................

......................................................................................................................................................................

http://www.vizrt.com/
http://documentation.vizrt.com/
http://www.vizrt.com/training/
http://forum.vizrt.com/
http://www.vizrt.com/
http://www.vizrt.com/
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1.5 Customer Support Requests

Support Requests are supported by Vizrt if customers have a valid Service Agreement in operation. 

Customers who do not have a Service Agreement and would like to set up a Service Agreement should 

contact their regional sales representative (see ).Customer Feedback and Suggestions

When submitting a Support Request, relevant and correct information should be given to Vizrt Support, to 

make sure that Vizrt Support can give the quickest and best solution to your Support Request.

This section contains the following topics:

Before Submitting a Support Request

Submitting a Support Request

1.6 Before Submitting a Support Request

Before a Support Request is submitted make sure that you:

Read:

The relevant User Guide or Guides

The release notes

and Check:

That the system is configured correctly

That you have the specified hardware, tested and recommended versions

Always refer to your Vizrt Service Level Agreement document.

1.7 Submitting a Support Request

When completing a Support Request, add as much information as possible.

1.7.1 Content of a Support Request

The report should contain information about these topics:

Problem description: Include a good description of what the problem is and how to reproduce it. 

Specify your workflow. Remember to use simple English.

Screen shots and illustrations: Use these to simplify the message. These are extremely useful for 

Vizrt Support.

Software configuration: Add exact versions of software used. This is extremely important 

information. The version information is available in the log.

System log files: Send the system log file. You can save your log file in the .link to Logs pane

System locale: Specify the Region and Language settings of the system.

Hardware configuration: Add exact versions of hardware used, especially for Viz Engine.

Optional:

System setup: Describe differences in the installation, if any, from the recommended setup.
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1.  
2.  
3.  
4.  
5.  

6.  

System Network: Add a description of how the network, bandwidth, routers, and switches are 

configured.

Always refer to your Vizrt Service Level Agreement document.

1.7.2 To submit a Support Request:

On the  page, click on Support.www.vizrt.com

Click on .Report a case

Click on  to login to the Customer and Partner portal.LOG IN

At the top of the Case Management page, click on .Report a Case
In the online form complete the required minimum information (shown by a red asterisk) and click 

.SAVE
In the saved Support Case that opens, complete the various text boxes and upload any required 

documents, files, etc. (see ).Content of a Support Request

To  of open support tickets, login to the Customer and Partner portal. Add track the status
information or communicate about the cases directly with the support team.

http://www.vizrt.com/
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2 Setup

The Template Builder follows the Pilot Data Server installation and opens as a web application in a 

browser.

The URL to access Template Builder is:

http://pds-host-name:8177/templatebuilder

2.1 Graphic Hub Connection

If Graphic Hub functionalities are needed to specify default values for geometries, materials, video, image 

and font fields, a Graphic Hub URL address must also be provided:

http://pds-host-name:8177/templatebuilder?gh=ghhost

Info

Enter the Template Builder URL first, and then add ?gh=ghhost afterwards

......................................................................................................................................................................

......................................................................................................................................................................
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3 Using the Template Builder

This section will explain the user interface of the Template Builder and how to use it.

In addition to a brief overview of the user interface below, the following topics are explained in more 

detail:

Template Preparation

The Template Builder Window

The Fill In Form

The Preview Window

3.1 Open a Template

Template Builder is a tool for editing and customizing existing templates.

From the main user interface, select the  button to browse for an existing template available within Open
the Pilot system.

In the  dialog, browse the desired template by selecting and . The Open Template CONCEPT TAGS

template search can be narrowed down by searching for the template name in the  field at Type to filter...
the top.
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3.2 Main User Interface

The main user interface is divided into three main windows.

(1) The Template Builder Window 

(2) The Fill In Form

(3) The Preview Window

The Preview Window (3) provides snapshots of the graphics with content. The preview snapshots provide 

the user with an idea of how the graphics will look like when played on air and are updated as changes are 

being made in the Fill In Form (2). In the Fill In Form the user fills in/edits content for the graphics. The 

field information, exposed fields, and layout in the Fill In Form can be customized by the user in the 

Template Builder (1).

3.3 Save

Saving,  , changes made to an open template in the Template Builder will overwrite the template in 

the Pilot Data Server.

3.4 Restore

The restore button,  will undo all changes since the last save.
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9.  

3.5 About

Clicking the Template Builder logo  in the top left corner of the application takes the 

user to the about page.

Here is information about software version, link to local documentation and link to third party licences.

3.6 Template Preparation

The current version of Template Builder relies on templates being generated and organized using Viz 

Pilot's Template Wizard. The following procedures will give you a quick introduction on how to create 

and manage a template. For more information on how to work with Template Wizard, please see the Viz 

.Pilot User's Guide

3.6.1 Creating a Template

The following procedure explains how to create and save a template.

To create a template:

Start Template Wizard

Connect to your Viz Engine

On the File menu, select Wizard

Drag and drop the scene to the Selected Scenes pane (right)

Click Finish

On the File menu, select Save (Ctrl+S)

Enter a Template name

Select a Concept name (or create a new)

Click Save as New

http://docs.vizrt.com/viz-pilot.html
http://docs.vizrt.com/viz-pilot.html
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3.  
4.  
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3.6.2 Managing Concepts and Variants

The following procedures explain how to organize a template for use with more than one concept and 

variant, for example a Blue and Red concept with a lower and upper third graphic. As a prerequisite all 

scenes should have the same type of data in order to use the same template.

To manage concepts:

On the Tools menu, select Template Manager

Under the Concepts - All pane, click New

Enter a name for the new concept and save it

Open the other concept

Drag and drop the template from the old to the new concept (and confirm the operation)

Open the new concept

Edit the template by selecting the correct Scene folder for your new concept

Save and confirm the operation

To manage variants:

On the Tools menu, select Template Manager

Select your concept, then the template

Under the Template variants pane, click New

Enter a Description of the variant

Select the Scene name that is a variant of the other

Save and confirm the operation

3.7 The Template Builder Window

The Template Builder window is located to the left in the application and is where all the customization of 

the template is done.

3.7.1 Settings

At the top of the Template Builder Window a  drop-down list is available, which allows for the Settings
following template settings:
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Duration

The duration setting can be used to specify the duration of the item. A default value is used when 

unspecified. Minimum and maximum duration values may also be specified. If these are set to the same 

number the item will get a fixed duration.

Track

Setting a  in the track settings allows for grouping of graphics in the timeline editor, see Name Track 

. The  sets the position of the group in the timeline editor, settings displayed in the timeline editor Index
where 0 is the lowest position.

Track settings displayed in the timeline editor

Title generation

The title generation setting allows for auto-generation of the title. The title can, for example, be text with a 

placeholder for one or several Field ID's. The placeholder is the {field ID path}. An example is shown 

below:

WARNING

Make sure to use the same index for the same name in all modified templates

......................................................................................................................................................................

......................................................................................................................................................................
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3.7.2 Field Tree

Each line in the Field Tree displays the ID and the label of a field in the template. It also contains an icon 

indicating the  of the field.Type

The listing of Fields can be rearranged by drag-and-drop within the Field tree.

Right-clicking a Field a list of choices appears. From here Fields can be added/removed,  can HTML panel

be added, Field ID can be changed and the selected Field can be deleted.

The Fill In Form will always immediately update upon any change.

WARNING

The auto-generated title does not get trimmed inside Vizrt web clients. However, if the title is longer 

than 128 characters it will be trimmed when dragging out the MOS XML file due to size constraints. 

This will affect the element title in the newsroom system.

......................................................................................................................................................................

......................................................................................................................................................................

Info

Only Fields created in Template Builder can be deleted and given a new ID.

......................................................................................................................................................................
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Each Field line can be customized using a set of properties which are displayed in the bottom half of the 

Template Builder window. Mark the desired Field in the top window, and the following properties can be 

set:

Label

Specifies the label of the field in the Fill In Form.

......................................................................................................................................................................
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Tip text

A tooltip text can be entered to give more information about the field.

Read-only

Selecting the  checkbox will keep the field visible, but grayed out in the Fill In Form.Read-only

Hidden

Selecting the checkbox will hide the field in the Fill In Form.Hidden 

Type

The type of content allowed in the field in the Fill In Form are set using the drop-down list under . Type
Depending on the type selected different sub-choices become available which is included in the table 

below.

The following types are available:

Type Icon Description

Empty
 

Will make the field unavailable. 

Typically used as a container for 

other fields.

Plain text
 

The field is a text field.

Max length: Set the number of 

maximum characters in the field.

Normalized text
 

Normalized text.

Max length: Set the number of 

maximum characters in the field.

Formatted text
 

A text that allows formatting.

Max length: Set the number of 

maximum characters in the field.

Single-line: Check this box to 

specify that the rich-text editor 

should only allow one line of text.

Boolean Creates a checkbox which have two 

states; true and false.

Integer The field is an integer field.

Minimum: Set the minimum value 

allowed.

Maximum: Set the maximum value 

allowed.
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Type Icon Description

Decimal
 

The field allows decimal numbers.

Minimum: Set the minimum value 

allowed.

Maximum: Set the maximum value 

allowed.

Date and time Use the in the Fill In Date Chooser 
Form to select date and time in this 

field.

Two numbers (duplet) The field allows two numbers 

(decimal numbers are allowed).

Minimum: Set the minimum value 

allowed for both numbers.

Maximum: Set the maximum value 

allowed for both numbers.

Three numbers (triplet) The field allows three numbers 

(decimal numbers are allowed).

Minimum: Set the minimum value 

allowed for all three numbers.

Maximum: Set the maximum value 

allowed for all three numbers.

Image
 

Will make the field available for an 

image.

Video
 

Will make the field available for a 

video.

Font
 

Will make the field available for a 

font.

Geometry
 

Will make the field available for a 

geometry.

Material
 

Will make the field available for a 

material.

Map
 

Will make the field available to 

present and edit a map.

Custom
 

Using the custom type the media- 

and XSD- type can be freely 

specified.

List
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Limit with Choice

A Limit with choice checkbox is available for each field. This option allows the template designer to 

present the right content in a drop-down list. For more information and examples, see Limit With Choice 

.Option

3.7.3 Limit With Choice Option

A checkbox is available for each field in the Template Builder Window. The meaning Limit with choice 
and purpose of limiting the choice of a field are to present available content in a drop-down list. This 

makes it easier and less error-prone to fill the template with the right content.

One example where the functionality can be useful is when a Control Object moving Limit with choice 
(Omo) plugin is accessible in the template. Scenes using Omo plugins will originally be presented as 

integer values for the different elements in the Fill In Form. The  option can assign text Limit with choice
to these values to make it easier to select the right element.

An example of how this can be done in the Template Builder is explained below. In this example, there is 

a scene that can be displayed at the top, in the middle or at the bottom in the graphics. For the Omo plugin, 

these positions correspond to the values 0, 1 and 2 respectively. To assign text to these values, do the 

following:

Mark the Omo Field ID in the Template Builder.

Select the  option.Limit with choice

When clicking on the  button, a new window appears. Right-click to design the table by Alternatives
inserting or removing rows. Click in a selected row or press F2 to do inline edits.

Type Icon Description

There is no support for making lists 

in Template Builder, but lists can be 

available in the template from 

Template Wizard.

Note

The user must be aware of available control plugins in the template that have been exposed by the 

scene designer in Viz Artist.

......................................................................................................................................................................

......................................................................................................................................................................
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Double-click the table or press Return to insert , , and . Click tab or Ctrl + Name Tip Value Next, 
down, to continue filling the table.

In the table below the values now correspond to text. Exit the table when it is filled out
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The Omo field in the Fill In Form now contains a drop-down list containing the alternatives created 

above as text, as opposed to an integer field where the user would have to remember which integer 

corresponds to which position.

Use Sub-Choices

Selecting the option, a new checkbox is made available called . This Limit with choice Use sub-choices
functionality allows the set-up of several sub-choices for each choice.

For example, if the choices list different countries, sub-choices could list cities in each of the countries. 

See example below:

Mark the desired Field ID in the Template Builder.

Select both  and options.Limit with choice Use sub-choices 

When clicking on the  button, a new window appears. Right-click to insert or remove Alternatives
rows.

Double-click the table to insert , and which in this case is .Name Tip Sub-choice Label Cities
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Click the button to add the sub-alternatives.Sub Alternatives 

Exit the tables when they are filled out.

Instead of a text field in the Fill In Form, the field now contains two drop-down lists; the main 

choices, which in this case is a list of countries, and sub-choices with corresponding cities.
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3.7.4 The HTML Panel

As a part of the customization workflow, the user can add an HTML panel to the template, which is a 

functionality that gives the user full control over the template by using custom scripting and logic to build 

the template. The template can host a webpage by entering a web address in the Template Builder. 

Normally the aim is not to host a single webpage, but rather make a data integration HTML template.

A simple example showing how to connect a custom HTML template to a pilot template is shown . below

Keep in mind that this example shows a limited possibility of what can be done using the customized 

workflow. Using it in more advanced ways opens up to possibilities where the user has 100% control over 

the template.

Add HTML panel

The option of adding an HTML panel is available by right-clicking in the field ID list in the Template 

Builder window. Selecting the HTML panel field ID, its properties become available in the bottom 

window.

Adjust the size of the HTML panel shown in the Fill In Form using the  field.Height

In the  type in the web address.Source URL

The  drop-down list allows the user to hide available fields in the Fill In Form.Hidden fields

Custom HTML template

Using the custom HTML template opens up to full user control of the template using custom scripting and 

custom logic.

The following example will show how to create a simple custom HTML template in Template Builder.

In this example we are working with a simple custom HTML template showing the message Hello world 
when opened in a browser:
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How to see the custom HTML template inside Template Builder

Open a template in Template Builder and add an HTML panel to the template as explained above

In the URL field enter the URL of the custom HTML template

Now the message  should appear in the Fill In Form:Hello world

How to connect the custom HTML template to the pilot template
Following the example above, it is now ready to establish a two-way communication, or bind fields, 

between the HTML template and the opened pilot template. A new field is therefore added to the 

template:

Right-click on your HTML panel field, and choose Add field after

Give it the id 50

Change the fields type to Plain text
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A new field appears: 

 

To connect the custom HTML template to the newly created field, the custom HTML template is opened 

in an editor.

The payloadhosting.js file must be included in the HTML template. This file is located in the js folder in 

the template builder folder.

The entire block is replaced with:<body> 

Saving the HTML file and clicking , reloads the custom HTML template with the Refresh HTML panels
changes just made. Now a bi-directional connection between the editor and the custom template have been 

established. When typing either inside the template or inside the field with id 50, both fields should be 

updated at the same time. This way of binding fields will work for any HTML fields that have value 

support, which is typically  types and .<input> <textarea>

<body onload="vizrt.payloadhosting.initialize()">
     <label for="field_50">My input field:</label>
     <input name="field_50" type="text" id="field_50">
 </body>



25

1.  

2.  

Adding the  to the <input> element inside the HTML template is all that is needed for  id="field_50"

the two-way communication to be set up since we added a field with the id of 50. Any amount of these 

binding fields can be established the exact same way; the way they are mapped are via id.

This gives a simple way of setting up a binding field. Note that updating the elements <input> 

programmatically will still send data back and forth; which is great for automated data integration such as 

fetching live sports data.

Browser Caching

The user might experience browser caching behavior when trying to update and display changes in the 

custom HTML template in Template Builder. This is standard browser behavior and Template Builder 

does not have control over caching resources that the HTML file itself includes.

To prevent this browser behavior, following actions can be made:

Make sure the URL's to the resources are unique upon reload.

Note

To prevent two editors for the same field being visible at the same time, use the  setting Hidden fields
inside the HTML panel settings.

......................................................................................................................................................................

......................................................................................................................................................................
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2.  

3.  

The web server serving the resources could be configured to send Expiry headers set to 0. More 

detailed information on how caching works and how to modify these is out of scope for this 

documentation

Disable caching on the browser side. This is done differently per browser.

3.8 The Fill In Form

The window placed in the middle in the Template Builder is the auto generated fill in form for the 

graphics. It displays editable fields that are given the appropriate control plugins by the designer in Viz 

Artist where the user can add content to the graphic. What type of content that are allowed in the fields are 

controlled in the . Fields can be restricted to contain e.g. only text with a certain Template Builder Window

amount of characters, numbers within a specific range, media placeholders for media assets, or it can be a 

set of choices in a drop-down list.

As long as the fields in the Fill In Form are exposed controls made by the designer the added content will 

 be shown in the Preview Window .

At the top of the Fill In Form there are three options and .Edit all, Show all Refresh HTML panels

Edit all is an option to edit all fields in the Fill In Form. This is to provide a way to edit default values of 

fields that are set to read-only.

Selecting  displays all fields in the Fill In Form, even if the fields are set in hidden mode.Show all

Selecting  will reload the HTML panel(s) in the Fill In Form.Refresh HTML panels
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3.9 The Preview Window

The Preview Window is located to the right in the Template Builder, which displays snapshots of the final 

output in an ongoing preview process, providing the user an idea about the how the graphics will look like 

when played out in high resolution on a Viz Engine.

The Template Builder sends requests to the Preview Server which manages Viz Engines that provides the 

snapshots.

The toolbar at the bottom of the Preview Window allows you to adjust how to view the preview of the 

element graphics:

TA: Show/hide the Title Area

SA: Show/hide the Safe Area

K: Show the key signal for the graphics

Scrub the timeline back and forth using the slider.

The user can scrub the timeline of the graphic located at the bottom of the Preview Window by clicking on 

it. If the graphic contains stop points these will be marked on the timeline.



28

3.9.1 Auto-refresh

Auto-refresh is located at the bottom of the Preview Window and is by default toggled on which means 

that the Preview Window updates once there are any changes in the Properties Editor.

Toggle off  to turn this functionality off. To refresh the Preview Window in this mode click Auto-refresh

the Refresh button  or click inside the Preview Window.
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